Twilight Render is:
A photo-realistic rendering plug-in for Google SketchUp*.

Now realistic renderings are possible from within SketchUp without having to spend months or years learning some complicated software. With Twilight, it takes care of much of the hard work for you, so you can concentrate on designing and even enjoy rendering.


- Material Templates create complex materials with a click. Ceramic, Metal, Paint, Stone, Light Emitter, SSS and more.
- Continue Working in/Saving SketchUp Models While Rendering
- Multiple Render Methods
  - Biased (multiple) (non-progressive)
  - Unbiased (3) (progressive)
- Multithread to Unlimited Number of Processors. (1, 2, 4, 8, or 16 cores in your machine? No problem. No extra charge!)
- Alpha Mask for Selected Object(s)
- Render Selected Object(s)
- Parallel, Spherical, or Physical Cameras
- Physically accurate materials, Fresnel reflections, Blurry Metal Reflections, Sub Surface Scattering, Volumetrics and more.
- Depth of Field (DOF) easy as a mouse click
- View Framing Tool to help with precise camera setup.
- Image Based Lighting (HDR), Use an HDR to light your scene, or Render your own spherical HDR images (save as OpenEXR)
- Interactive Tonemapping = Real Time Interactive Exposure Adjustment
- Render to Pass (works with selected object/group/component too!) Alpha Mask, Depth Render, Diffuse Pass, Specular Pass
- Render fly-thru animations and more with little fuss
- Render Animated Lights, Sun & Sky, or Objects Object animations created with SketchyPhysics or ProperAnimation for SketchUp are supported. (these plugins are available separately from their authors.)
- Automatically Recognizes Alpha channel for PNG, PSD, Tiff, TGA images when applied to surfaces in SketchUp.
- Save images as .jpg, .png, .bmp, .tif, .hdr, .exr
- Render Quick Concept Images or get as Photo-Realistic as you want to make it.
- Render Edges of Faces and you keep full control of the edge thickness**
- Languages, choose one from the options menu - English, Spanish, French, German, Chinese, Japanese ... and more to come

*Wherever the name "SketchUp" is used, it is noted that it means Google SketchUp. Google Inc. and SketchUp are copyrighted/trademarked entities and are not affiliated with Twilight Render. **Edges that do not form faces can not be rendered.
Twilight Render User Manual Table of Contents

Twilight Render is: ................................................................. 1
Overview ........................................................................ 4
To render in (6) simple steps.............................................. 4
How to Get Great Renderings ............................................. 4
The Twilight Toolbar ......................................................... 4
Section 1: The Render Dialog .............................................. 5
Render Dialog Menu Bar .................................................. 6
Render Dialog Toolbar ..................................................... 7
Settings Window Frame ................................................... 8
Camera Tab ...................................................................... 14
Advanced Tab ................................................................... 16
Animation Tab ................................................................... 17
Render Window .................................................................. 19
Troubleshooting .............................................................. 21
Section 2: The Omni (Point) Light Tool ................................. 23
To place an Omni Light in your scene: ................................. 23
Section 3: The Spot Light Tool ............................................. 24
To place a Spot Light in your scene: .................................... 24
Section 4: The Light Editor Dialog ....................................... 25
Standard Light Options Tab .............................................. 25
Spot Options Tab ................................................................ 26
IES (Photometric) Light Options Tab ................................. 26
Projector Light Options Tab .............................................. 27
Sun & Sky Options Tab ..................................................... 28
Section 5: The Material Tool ............................................... 29
Material Previews .......................................................... 29
Material Templates ......................................................... 30
Material Template Choices Overview ................................... 33
Material Libraries ........................................................... 37
Section 6: The Twilight Options Dialog ................................. 38
Directories and Files ....................................................... 38
Dialogs ........................................................................... 38
Advanced ........................................................................ 38
About ............................................................................. 38
Twilight Language .......................................................... 38
Section 7: Position Scene View Tool .................................... 39
The Position Scene View Frame ......................................... 39
Focal Point Center Axis ................................................... 39
Rotation / Orbit of the View .............................................. 39
Pan the View .................................................................... 39
Look Around (Swivel the Camera) ..................................... 39
Focal Point ...................................................................... 39
Section 8: Reference .......................................................... 40
Batch Rendering ............................................................. 40
Background Images On “Billboards” or a “Plane” (Face) In SketchUp .............................................................. 40
Bump Mapping and Bump Maps .......................................... 41
Codec ............................................................................. 42
Color Codes - RGB, HEX .................................................. 42
Custom Material Templates and Material Libraries .......... 42
Faceted Geometry of Curved Surfaces ................................ 43
HDR ............................................................................... 43
IES Data Files (.ies) .......................................................... 44
Light Portal: see Sky Portal ............................................ 44
Light Through A Window ................................................ 44
Lighting An Interior Scene .............................................. 45
Material Priority ............................................................. 46
Model Processing Phase .................................................. 46
Multithreading and Rendering Machine Recommendations .. 47
Post-processing (aka Post-Pro, or PP) ................................. 47
Proper Animation for SketchUp (+ Mover.rb Animation) ...... 48
Proxy Object/High Polygon Object Rendering/Handling ...... 48
Reflection Maps (Specular Map) ........................................ 49
RGB (Red Green Blue) .................................................... 49
Scratch Map ..................................................................... 50
Share a Twilight Render Scene with another user: ............... 50
SketchyPhysics Animations .............................................. 51
Sky Portal: for interiors lit only using Sun and Sky ............... 53
Spherical Sky (Skies) Background ...................................... 54
Themes for Twilight User Interface ................................... 54
Two-Point Perspective (2-Point Perspective) ....................... 54
Uninstall/Reinstall Twilight Render .................................... 55
Credits ............................................................................ 56
Overview

To render your completed SketchUp model using Twilight follow these (6) simple steps.

1. **Insert Lights** (The physical Sun & Sky are automatically set using SketchUp’s™ Sun and Shadow settings)
2. **Apply Twilight Material Templates to SketchUp Materials** (metal, glass, plastic, ceramic, stone, light emitter...)
3. **Choose a Render Setting** (quick, medium, high quality, or multiple unbiased progressive rendering methods are available)
4. **Choose a Render Size** (output resolution)
5. **Start the Rendering**
6. **Save the Rendered Image**

Great renderings need four (4) things.

1. Good Models (A poorly detailed model will look as such, or even more clearly so, in a rendering.)
2. Good Lighting (A well-lit model is simple in Twilight if you follow the principal of “light it as you would do so in real life”.)
3. Good Materials (Quality materials are key to convincing renderings. Learn to observe the world around you closely.)
4. A Quality Render Engine like Twilight Render.

The Twilight Toolbar

- **The Render Dialog** button, or “Power Button,” for short, Opens the Rendering dialog allowing you to choose all rendering parameters such as resolution, camera settings, animation settings, and to start your rendering.
- **The Omni Light Tool** - insert an Omni Light (Pointlight). An Omni Light casts equal amounts of light in all directions.
- **The Spot Light Tool** - insert a Spot Light. A spot light is manually adjustable to cast light in a certain direction with a definable “HotSpot” angle and a “Falloff” angle.
- **The Light Editor Dialog (+Sky)** is a listing of all lights in the scene, allowing easy access to full lighting control. This is also where you can choose Sun & Sky parameters as well as utilize an HDR or Spherical Sky or other type of background image.
- **The Material Tool** - quickly apply physically accurate material properties to any SketchUp material painted on a face in your scene.
- **The Twilight Options** - set advanced options for Twilight, Choose a Language, Activate a License.
- **The Position Scene View Tool** (View Tool) allows you to accurately frame your view and set a focal point for your camera.
Section 1: The Render Dialog

Click a topic to jump to it's link below.

1. Render Dialog Menu Bar
2. Toolbar
3. Settings Window
4. Render Window
Render Dialog Menu Bar

1 Render Menu
The Render menu allows you to start the rendering or exit and close the Twilight Render Dialog.

2 View Menu
The View menu allows you to re-open the Toolbar or the Settings Window if they have been closed.

3 Cameras Menu
The Cameras menu lists all cameras in the scene. If you choose a camera in the list, Twilight will render only that view, no matter what is showing in the Google SketchUp view window. This forces a rendering of a certain camera while editing the model.

4 Layers Menu
The Layers menu allows you to choose a layer or layers to be ignored during the rendering. De-selecting the dot next to any layer name in the menu list means that you may see the layer in the Google SketchUp View, but it will not be processed or rendered by Twilight.

Perhaps 2D plants or 2D people are desired in the SketchUp scene exports, but not in the Twilight rendered output.

5 Layouts Menu
The Layouts menu allows you to save different configurations of the render dialog, and recall them at any time. This is useful if you like to close the Toolbar and Settings Window to give more screen real estate to the Rendering Window. Then you can use a previously saved layout to restore the Settings Window and Toolbar quickly.

6 Closing the Render Dialog
After clicking the “X” to close the Render Dialog, Twilight will prompt you to let you know that even though you have closed the dialog, the rendering will continue in the background. Think of it as the “hide” button for the Render Dialog. To get the dialog back, simply click the Start Button again.
Render Dialog Toolbar

1  **Start Render Button**

The Start Render Button begins rendering the scene using the parameters defined in the render dialog. If there has been no Render Setting chosen, it will use a preliminary test render setting.

2  **Stop Render/Cancel Render**

The Stop Render / Cancel Render button stops the rendering in progress. It is not available during the Model Processing Phase.

3  **Pause/Play Button**

The Pause/Play Button allows you to pause a rendering in progress. When clicked the button then becomes a “Play” button which, when clicked, resumes the rendering again... that is, it allows you to continue the rendering from where it left off when it was paused. If SketchUp's session is closed, you may not ‘resume’ a rendering.

4  **Save Rendering Button**

The Save Rendering Button allows you to save the rendering to the hard drive or network. The save image default is .jpg at 100% quality. To change to another format, simply type in the extension. Available extensions are .jpg (8 bit), .tif (32 bit), OpenEXR .exr (32 bit), .bmp (8 bit), .png (8 bit), by typing the desired extension after the file name.

5  **Export Scene to Kerkythea XML Button (for rendering the model with Kerkythea)**

The Kerkythea XML Export Button exports the scene for further development/rendering with Kerkythea Rendering System. There you can utilize smooth camera animation rendering, and inserting hi-poly vegetation content along with the Instancing Brush for populating quickly hundreds of thousands of instances of objects. Also by leveraging Kerkythea you can do advanced/in-depth material editing, save and share material libraries for future use, create and share specialized render setting presets for use with Twilight, merge in other file formats (like models in .obj format) into your scene, and much more.
Rendering

Settings Window Frame

Render Tab

The Preset Tab has four parts.

1. The Render Preset List
2. Render Size (resolution of the rendering)
3. Fit To View Proportions
4. Saving Render Method (Incremental Save)

1 Render Preset List

The Render Preset Window lists all the render setting presets available for use with Twilight.

To set or choose the desired render preset, simply click the name of the desired preset. You will see it Loaded into the “Preset:” line.

This window has a Presets Folder Tree. The Folder Tree is showing the folders containing render presets that are located in the Twilight Plugins folder on the hard drive. In WindowsXP (for example) it is located under “Google SketchUp7\Plugins\Twilight\RenderSettings.”

By default Twilight uses the “Low” setting found in the “Easy Settings” folder.

Navigate the Presets Folder Tree by clicking on the plus sign next to a folder name to expand a category folder, or by double-clicking a category folder name. Twilight comes with several folders. These may be modified by using a file browser and going into the folders to add/delete/create/arrange folders and settings however desired.

These folders can be located on a network drive location... and found by Twilight by designating the folder in the Options>Directories Dialog.
Easy Settings:

As a good rule of thumb: Start low and work your way higher. If you are not getting the result you want in a setting, try the next higher setting. If the number of lights is low, higher settings may be required for good lighting results, and therefore, as the number of lights increases you may want/need to use lower render settings. Also, the larger the rendering resolution, the lower the render setting you may need. The "*" settings have much higher quality AA. Only the "High" settings use true caustics. The others use pseudocaustics to get quicker results.

With non-progressive render methods (found in the "Easy" category under the names "Low, Medium, and High") the render setting preset assigns more than 100 different parameters automatically. Choosing wisely is important. It will be the tendency of an inexperienced person using Twilight to automatically choose "High" as their render setting. In actuality an experienced user may find that Medium gives great results most efficiently in many cases. Also, it is wise to render preliminary renderings on the Prelim setting.

If there are many lights (more than 10), and no metallic or blurry reflective surfaces the "Low" render setting could serve quite well and render very quickly indeed. While if there are blurry metals or blurry reflections on surfaces then a settings with a "*" will be a better choice. "09. Indoor Progressive" will be one of the best quality, but will have longer render times in many cases. However, it may serve well as a fairly quick preview for larger scenes.

AA (Anti-aliasing) is built into all "Easy" settings (except for "Prelim"). It varies in quality per Easy setting.

Some materials are especially made to 'fake' some effects (no shadows, fake light) and can only be rendered this way with Easy Settings 1-8. Some materials will render ok with the Low-High render presets, but will be best shown in the progressive rendering methods (blurry metals, translucent and Sub-Surface Scattering materials). All materials render well with the progressive rendering methods, but these methods do not allow things to be "faked", so a material that "fakes" casting no shadows will still render with shadows in a progressive render method. Fake light emitting surface will actually emit light in a progressive render method. For this reason one should avoid fake emitting surfaces with progressive render methods as they may produce more light for the scene than intended.

People experienced with Twilight may find themselves choosing Preset #09 the most for interiors, while for exteriors they may choose Preset #08. For exteriors lit only with Sun & Sky Preset "#08 Exterior Progressive" will be not only the highest quality, but possibly also the fastest method. This is especially true for those with multiple processors.

Examples at left rendered on:
Intel Centrino DuoT2500 @ 2Ghz with 2 Threads.
Advanced Settings:

Clay Render: This is used for checking the lighting without worrying about the materials.

The Clay Render is a way of saying “check the lighting without materials/textures”. It is useful when you have a model either untextured, or partially textured and are looking for a quick preliminary rendering. This setting is more advanced than many other render engines and their clay render settings because it automatically replaces all materials in the scene with a clay material without changing the bump mapping, and returns them to their original state when finished. It is also a “Smart” preset that leaves Light Emitting Surfaces and Thin Glass (Architectural Glass) as they are, to allow for easily running clay renderings for interior images. If materials have a bump map applied, the bump will still render without the color or texture.

Alpha Mask: This is used for isolating geometry in post-process image editing.

1. Select an object.
2. Choose “Alpha Mask” as your render method. (Camera Tab: Be sure exposure and gamma = 1.0)
3. Start the rendering.
4. When asked to render only selected objects choose “yes”.
5. Open the Camera Tab and set tone mapping to “NONE”. (so that white will be pure white)
6. A black and white image will be created of the object.
7. Save the rendered mask image.

This black and white “mask” is for use with photo editing programs in post-processing. By placing the generated mask in the Mask Slot for a layer in your image editing program, the item rendered will be isolated. Most common uses for this are for isolating furniture for post-processing objects behind the furniture such as people. Also it is commonly used in architecture for post-processing in a high-resolution (hi-res) sky image.

Ambient Occlusion: This is a quick way of rendering “ambient” lighting.

It works best if the sun and lighting are turned off. It quickly calculates/approximates the adjacent shadows from nearby objects. This is commonly known as how one object’s lighting may “occlude” another’s lighting.

Animation Interior

One possible render preset optimized for interior renderings. The “Animation” presets have something ‘special’ in them that will avoid sparkles, etc. They will, depending on the scene, take longer to render than this one. This setting will not look good with scenes using blurry metals or subsurface scattering materials.
Depth Render

Renders a greyscale image that assigns different values of grey for different distances from the camera. Useful for post-production in a photo editing program when manually recreating a Depth Of Field effect, or complex masking, fog effects, or other post-production tonemapping, coloring, tinting, or highlighting techniques.

See also the Render Pass Reference Chart in the Tech Render Settings section.

Light Pass

Renders an image showing only the light sources in the view. This will include light emitting surfaces, and the sky seen thru a window.

Animation Render Settings

If animating only camera, you can lock the light cache by choosing “Reuse Lighting Information” checkbox in the Animation Tab of the Render Dialog. This is a way of saying that the “precalculation” of general illumination will not need to be calculated more than once for the animation. This not only saves render time, but also causes the lighting in the render to have no ‘flickering’ from varying lighting calculations.

However, if you are rendering object animations it is not possible to lock the light cache. So the animation settings were created with special attributes that allow for steady lighting throughout the animation without render times increasing greatly.

These settings are also proving useful in other applications as well, such as with quick exterior renderings.
Tech Settings:

The Tech settings contain more render setting presets organized by render method. These are the legacy render settings for the convenience of Kerkythea users coming to use Twilight.

Here are some examples of render passes available in the Tech Render Settings folder for use in post production:

- **Diffuse Texture Pass** is useful for many things including use as a quick selection mask for all parts of an image with a certain texture in post production image editing or test rendering animations. Depth Render can also be used for test rendering as well as making fog or lens blur in post production.

**You may create your own settings** by opening a copy of any setting inside of a text editor like "Notepad" and changing the values you wish to modify then save it with a logical name into the **Custom** folder. You will need to close and re-open the Render Dialog in order to see/make the new setting available for use. You may also use Kerkythea 2008 Echo to create a render preset and then save this into your Twilight Render Settings folder structure. Please refer to Kerkythea's documentation to learn more about creating render settings using Kerkythea.
2 Render Size

This is the resolution of the rendering in pixels. Click the chain link to toggle the proportion lock. Clicking the magnifying glass will reset the resolution to match the size and proportion of the SketchUp viewport.

3 Fit to View Proportions

With this box checked, no matter what resolution you choose for the “Render Size”, Twilight will render the image using the proportions shown on the screen, and show you the resultant “actual size” resolution in pixels of the rendering below.

If this box is checked when using the Position Scene View Tool the view frame will fill the screen.

4 Saving Render Method (Incremental Save)

This option allows you to save a rendering automatically and incrementally in a format and to a place of your choice. When choosing any render saving method except for “Manual”, the image will be saved while it is in progress of being rendered. It will also be saved automatically at any time that the rendering is stopped.

After making a selection from the menu, then clicking the Start Render button, you will be prompted for a rendered image location and name. Type in the name under which you desire the image to be saved, and add an extension for the image type to be saved. (.hdr, .png) Be sure to select carefully the type of image to be saved. Without an extension, the image will be saved as a high quality .jpg format.

Incremental saves work with all render methods. Keep in mind if incremental saves are used with non-progressive render methods (Easy 1-7) the image will not necessarily be completed when it is saved. For instance, if a computer failure or power failure happens during a rendering and it has been saved in progress using the Incremental Save feature, the image will likely have no anti-aliasing.

“Automatically when finished” option simply allows you to define a name and place to save the final render, and when it is complete it will be saved.

“No overwrite” means that it will add a number to the name of the rendering for each incremental save.
Camera Tab

1  Projection:

Planar = Match SketchUp's Camera (Default)
Cylindrical = Render a Cylindrical Panoramic view. For use in virtual tours, or as cylindrical background images.
Spherical= Render a Panoramic Spherical Image, an image with spherical projection. For use in virtual tours for example.

When saved in .hdr format Cylindrical and Spherical image types can be used to light other scenes in Twilight.

Parallel = Render the scene without taking perspective vanishing point convergence into account. Great for rendering an elevation, isometric, or section view. (SketchUp’s Section Cuts are not rendered automatically in Twilight. However, plugin ruby scripts like “Zorro2” by Whaat are available which can be used to modify a model quickly for rendering a section perspective.

2  F-Number:

Lighting and Cameras in Twilight are best thought of just as in Photography. Depth Of Field (DOF) (blurring of objects as a function of distance from the camera) in Twilight is a function of the F-number and the camera’s focal point. It is also a function of the View Angle set in SU using the magnifying glass and holding down the Shift key. The higher the F-number, the clearer the image, that is, the DOF effect will be less noticeable. Wider Angle fields of view (>50 degrees) with shorter focal lengths give greater depth of field. Use higher F-number for larger objects and larger distances. The F-Number must be used in conjunction with the Twilight Position Scene View Tool.

Hold down the Ctrl key and click a point on an object in your scene where you want the camera to be in sharp focus to set the Camera’s Focal Point.

Change the F-stop on the camera here as shown default to “Pinhole”. This number is a fraction (2.8 = 1/2.8). In the “real world” each “step” on a camera equals twice as much light entering the aperature. In Twilight, each step in general will simply decrease the DOF effect. If 2.8 = very blurry, 32 = clear.

When rendered, you will now see Depth of Field, depending on the scene. Things in front of or behind your focus object should be a bit blurry, depending on their relative distance to the camera and the F-number chosen.

Be sure to “Update” your SketchUp camera “Scene” right away AFTER choosing a Camera Focal Point. This will save your DOF view for later use. Choosing a previously created scene after setting the camera’s target will change the focus of the camera.
3 Filter:

Filter = type of Tonemapping.

Tonemapping is simply the modification of an image to control its highlights and dark areas to achieve an image “look”. Tonemapping is as crucial for getting a nicely rendered image as the exposure setting is to a real camera.

Tonemapping in Twilight is achieved in the Camera Tab. Choose the Type of Tonemapping Filter, then set the parameters such as the Exposure or Gamma.

⚠️ It is recommended to adjust the Exposure first, and change the Gamma only when absolutely necessary.

You may think of Tonemapping like adjusting a camera’s exposure on-the-fly. You can tonemap the image manually by increasing or decreasing the exposure of the image at any time during the render process.

⚠️ Tonemapping may be adjusted at any time during or after the render process. As long as the rendered image remains in the window.
**Advanced Tab**

1. **Content Updates:**

   There are several ways to have the scene updated:

   - "All" makes Twilight process everything in the scene for every frame or image that will be rendered.
   - "Camera & Lights" or "Camera Only" tells Twilight that you have not changed anything in the scene except a light or camera. This causes the processing phase of test rendering progress to go much more quickly for doing a series of test renderings on large scenes since it will only be updating the lights and cameras.
   - "None" will re-render with last-exported content, as if there have been no changes to the scene at all.

   "Camera & Lights Only mode should be used cautiously because it is easy to 'forget' this option has been set. If something changes in the geometry or materials of the model, the user will wonder why they have not been incorporated into the rendering. If your model is not updating materials or geometry when you render, be sure to check that this setting is set to "All" and re-render. This settings remains across sessions, so remember to set back to "All" when closing the SketchUp file.

2. **Grouping Method:**

   There are two methods of grouping the content of a scene. One fast, and one slow. They are both of equal quality.

   - **Definitions/Instances** processes any component definitions in the model as an instance for Twilight to render. This not only increases the speed and efficiency of processing, but also the speed and efficiency of rendering.
   - **Per Material** ignores components in the scene. This method could be very slow for larger scenes. It will also increase render times for larger scenes, or cause your machine to run out of RAM.

   It is not likely that you will need to change this method. Try this method if having trouble exporting a scene to XML or to help in more easily editing materials in Kerkythea.

3. **Threads:**

   Threads = Number of Threads provided by your processor(s) to employ in rendering the image. **Multithreading** means that the computer is utilizing more than one Thread to do a task. Twilight will by default render with the maximum number of threads found on the machine. **Twilight's render process is always in Low Priority Mode so as not to disrupt other processes on the machine.** Eventhough it is using all threads, this allows you to continue working in SketchUp and other programs while rendering with little performance degradation, depending on the machine and render method. Please avoid changing this setting unless you know what you are doing.

---

**Update Method:**

<table>
<thead>
<tr>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
</tr>
<tr>
<td>Camera &amp; Lights</td>
</tr>
<tr>
<td>Camera Only</td>
</tr>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

**For more tips on controlling processed content, see the section entitled "Model Processing Phase."**

**Rendering Selected is an additional way you can choose the content to render from the Scene.** Choose an object to render and start the rendering. Twilight will ask to only render the selected object. If you choose "yes", you must be sure to select a light to render with the object as the lights selected are taken into account.

**To find out how many threads your computer has:**

Open Task Manager in Windows (right-click your desktop) and look at the "Performance Tab". This example shows a machine with 2 threads.
Animation Tab

1 Animation Pull-down Menu:

Choosing “Only View” will “turn on” animation rendering and cause Twilight to render the fly-thru animation as it has been set up to do in your scene’s tabs utilizing SketchUp’s native scene animation feature.

Any scene which has been excluded from the animation by unchecking the “Include in Animation” check box in the SketchUp Scene Manager Dialog Box will likewise be excluded from the rendered animation in Twilight.

*See Also: Proper Animation for SketchUp

*See Also Batch Rendering

*See Also Codec Info

Set Scene Delay to Zero (0) before rendering your animation. If not, SketchUp’s animation control will tell Twilight to render the same frame over and over for the duration of the Scene Delay in order to make the animation video appear to have the delay time specified. To add delay later, use your video animation production software to create scene delays.

Since all lighting in the scene is taken into account by Twilight whether it is contributing light to the currently rendered frame or not, it is wise to turn off lights that do not contribute in a significant way to that particular scene. This becomes vital in reducing rendering times for animations. If rendering a scene that does not require sun or sky be sure to disable the Sun and set the sky color to “Background”.

Twilight will calculate all direct and indirect lighting for all lights on all geometry processed in the scene, whether it is seen by the camera or not. For example, one may want to set animation scenes to turn off hi-polygon geometry such as furniture in certain spaces if these spaces will not actually be seen or need to be rendered during a portion of the animation.

Animating the turning on and off of lighting is achieved by leveraging Scene Tabs to control layers or hidden geometry. By putting lights on layers whose visibility is turned on and off via the SketchUp Scene Manager they will be turned on and off during animation. In the animation pull-down, simply choose “Has Animated lights/Sun. If rendering with animated objects be sure to choose appropriate pull-down option.

Rendering animations produce a series of images. In order to view the animation, you need to “render” the images as a “movie”. This can be done easily by opening the rendered images as an “image sequence” using a tool such as Windows Movie Maker or the free and easy-to-use VirtualDub... or by using full video editing suites like Adobe Premiere or Sony Vegas. Then you must save the movie as a movie format such as “.avi”, .mpg, mp4, .swf, etc. A movie .avi file, even of a short video, can be quite a big file, so it is wise to encode the video in a compressed format using a codec.
Rendering

2 Start (s):
This will read as (0) “zero” at first. You may leave it at (0), or if rendering an animation in “pieces” may choose any second of time to start the animation rendering sequence.

3 Stop (s):
This will read as (0) “zero” at first. If you have 3 frames, you have 2 transitions between them. If SketchUp’s Animation Transition Time is set to 2 seconds, then 2 transitions x 2 seconds = 4.00(s) of video. If rendering an animation in “pieces” you can specify any second where you want to stop the animation.

4 Jump
Clicking this button will cause the view in SketchUp to “jump” to the frame at the time specified in the dialog box... or step through the animation using the Arrow Radio Buttons.

5 Frame Rate
The “Number of Frames (Images) Needed per Second of Video”, also thought of as the “Rate the Frames Are Shown Per Second.”

6 Starting Frame #
Defines what number to attribute to the starting frame that is rendered. If you have 10 frames to render, and you choose “8” as the Starting Frame Number it will render all 10 frames, but name the files like so: Frame0008.jpg, Frame0009.jpg, ………Frame0017. Starting Frame # is NOT the frame number from which Twilight will begin rendering. You must set up the animation so that it will start and end properly where you wish by defining starting (time) second and ending (time) second of animation. If you are rendering 10 frames, and wish it to start rendering from frame 8, set Start of Animation to 7 and End of Animation to 9, and set the Starting Frame# as 8. It will render 3 frames like so: Frame0008, Frame0009, Frame0010. Using this feature will result in AUTO-OVERWRITING any frame with that name already in the file!

7 Base Name:
When rendering the frames of the animation, Twilight will automatically change the name of each frame to have a number after it. Click the “Browse” button to find the folder where you want the animation images to be placed. Type the name you want to use as the “Base Name” for all the animation images. The frames will be automatically saved in .jpg format for best quality and compression of color images. To save animation frames in a format other than .jpg, simply add a supported extension to the base name such as .tif (32 bit), OpenEXR .exr (32 bit), .bmp (8 bit), .png (8 bit)

8 SketchyPhysics Animation Options:
SketchyPhysics is a free plugin for SketchUp available here. It allows you to specify physical characteristics for objects in your model, then to play an animation to see how they will act in the real world. This animation can now be rendered using Twilight! See the SketchyPhysics Reference Section for a detailed tutorial on rendering your SketchyPhysics model.
Viewing the rendered image within the Render Window can be controlled with the scrollbars.

Clicking the **Save Button** will allow you to save your image by default in the highest quality .jpg format at any time during the rendering process. You may save the image in .tif (32 bit), OpenEXR .exr (32 bit), .bmp (8 bit), .png (8 bit), by typing the desired extension after the file name.

The rendering progress information is displayed on the notification line. During a rendering made using a Progressive Rendering Preset it will tell you which “Pass” is being completed. i.e. “822/10000”

Progressive rendering means that it will continue to render until the rendering is stopped or until it reaches 10000 passes.

It is not intended or suggested that the image be considered finished when it reaches 10000 passes, stop the render process when you consider the image to be sufficiently ‘clear’. For most images the clarity will not increase much noticeably after 1000 passes.

The **Number of Threads** being used while rendering is displayed like this (Threads:#)

The percentage complete of a particular “Pass” (not necessarily of the entire rendering process) is displayed next to the number of threads. The Anti-aliasing (AA) pass must be allowed to continue to completion or it is not applied to the rendering. A “Pass” can be thought of as a “phase” in a rendering process. Different Render Settings have different phases or “Passes”. Examples of a “Pass” are “Ray Tracing” and “Anti-Aliasing”.

**Backup of Rendered Image Temporary File Location**

For progressive renderings, a temporary backup file is saved to your hard drive in the application's data file. You will have to enable viewing of hidden folders and possibly extensions in your Windows setup in order to see the folder. This can be found on Windows systems looking for a “tmp_inprogress_image.png” in a path something like:

XP: C:\Documents and Settings\Username\Application Data\Twilight\temp\tmp_inprogress_image.png
Vista: C:\Users\Administrator\AppData\Roaming\Twilight\temp\tmp_inprogress_image.png
Windows 7: C:\Users\Username\AppData\Roaming\Twilight\temp\tmp_inprogress_image.png

The image is saved without tonemapping. Open the file in your image editor, and use the Exposure Control to lighten the image.
Image Context Menu

The context menu when right-clicking on the image gives you these options.

1. **Save Image**
   This is the same as clicking the Save Button.

2. **Refresh Image**
   Refresh Image will force the image to update its progress. By not updating the image constantly Twilight is able to save resources and render more quickly as well as allow you to continue working in SketchUp during rendering. If the render window is hidden/closed Twilight will 'refresh' the image even less frequently, and therefore improve performance and speed.

3. **Fit Image to Screen**
   Fit Image to Screen will squeeze the entire rendered image to fit into the current Render Window size.

4. **Stop Before Next Pass**
   “Stop Before Next Pass” is for use with progressive render settings. If these render methods are stopped after only a few passes, some 'pass' lines may appear on the image due to an unfinished pass. If stopping this method with the intention of saving the image, it is better to use this choice instead of the normal Twilight stop button.
Troubleshooting:

1

I have started a rendering and it is in the “Ray Tracing” phase, but the Render Window is empty or showing only black.

1. Did you turn off all the lights using the Light Editor Dialog?
2. Did you turn off all the lights by hiding the TWL_Light_Layer?
3. Did you turn off the Sun and set the background to the color of black?
4. Did you neglect applying a Twilight glass material template such as “Thin Glass” to any windows/glass for an interior rendering so that it will allow light to pass through the face? If your glass has an opaque material applied, light can not reach your scene.
5. Did you insert any Twilight Omni or Spot light inside of a component that is opaque, or did you accidentally change the glass material of your lighting component to be opaque using the SketchUp material's opacity slider or the Twilight material's alpha slider?

2

I have changed a material in my scene, but the rendering keeps showing the old material and will not update it.

1. If your model is not updating materials when you render, be sure to check that the setting for Updating Content is set to “All” and re-render.
2. If you paint the objects inside of a group or component with a material, then you paint the entire group or component with a different material, the material that is painted directly on a front face will take precedence, then the material on the component or group, then materials on back faces.
3. Materials painted on the front face will take precedence of the materials painted on the back face. Set the view of your model in SketchUp to “Monochrome” in order to quickly see if it is the front face that has been correctly painted with the desired material.
4. Be sure that there are not 2 planes with different materials sharing the same 3D space. If this happens, sometimes you will see one material rendered in SketchUp’s view, but the other plane and material will show in the rendering.

3

I have changed some geometry in my scene but the rendering keeps showing the old geometry and will not update it.

1. If your model is not updating geometry when you render, be sure to check that the setting for Processing Geometry is set to “All” and re-render.

4

There are black speckles (noise) all over my rendering.

Be sure that any light (spotlight or omni light) is not touching/sharing 3D space with other geometry or another object in the scene. Keep lights approximately 2 inches (5cm) away from adjacent geometry.
5 When I start the render, it says “Processing had errors” but continues rendering.

1. Are there layers or materials with strange or non-latin characters in their names? (~ ^ ' “) Foreign characters should be getting filtered automatically, but using only non-accented letters may help.

2. Was a material applied in the model from a material library which is not installed on the machine having the error? Find the missing material library and put it in the Plugins\TwilightMaterials folder.

3. Was there a material applied for which a texture file is now missing for some reason? Find the missing texture and put it in the same file with the .skp file.

4. Was there a light in the scene which incorporated an IES (photometric) file in it’s definition that is now missing (now on a different computer)? Find the IES file and put it in the same file with the .skp model.

6 I can not render my scene using “Medium” or “High” settings, but it will render with “Low”.

Some may find that for high geometry scenes with a lot of lights will simply not render at all on their machine with the Medium or High settings. This is due to the fact that the machine will be running out of RAM to contain all the information necessary to complete the rendering. The scene should render well with Easy Setting “09. Interior Progressive”. Another possible solution would be to eliminate any lights that are not significantly contributing to the scene, also to be sure anything in the model that appears more than once is made into a component, and the components are copied, not the non-component geometry. Leveraging the power of components in SketchUp will save much time in processing and rendering.

It is wise to be extremely cautious when utilizing models posted to the internet and available for free. (Downloading models such as from the Google 3D Warehouse.) This is due to the fact that many of these models are not built with the intention to render them, they are not built correctly, they may contain a lot of superfluous geometry or materials, or they may not be built to correct scale. Typically packages made professionally and posted as groups of models as a resource from a manufacturer are “safe” to utilize... but many of them have problems as well.

7 Twilight Material Appearance Priority Order:

1. Any face with a “Front” material applied will always use that material
2. If not -- If that face is in a group or component, if that group or component has a material applied, it will use that material
3. Finally -- if the face has a back material applied, that material will be used

8 My Dialog Box is missing, or somewhere off screen.

There is an option in Twilight->Options->Dialogs for resetting all saved dialog positions. If you choose it, it will restore the Render window to it's default position. “Reset All Saved Dialog Positions”
Section 2: The Omni (Point) Light Tool

The Omni (Point) Light Tool allows you to insert an Omni-directional Light. An Omni Light casts equal amounts of light in all directions (a little bit like a real light bulb). All lights in Twilight are by default set to attenuate light (light diminishes an amount over a distance), just as in real life, by the distance $d$. The exception to this is the Sun which effectively has no attenuation.

To place an Omni Light in your scene:

1. Click the Omni Light Tool

2. Click your light's Base Point. This is the place in your scene on a face or point near where you want the light to be placed. Drawing a temporary line where you intend to place the light may be helpful for guiding placement of a light. For example: draw a line crossing a circle so you can snap to the midpoint for the light.

3. Now click a second time to pick the insertion point of the Omni Light Component. To avoid lighting artifacts or problems, the component must not be touching an adjacent face. Moving the mouse in a direction you can specify the insertion point for the light itself. Use the Shift key to lock the inferencing, just as with many tools in SketchUp. With the mouse inferencing a direction you may also type in the distance and hit “Enter”. Now click to place the Omni Light Component. You should now see the Omni Light appear in your model.

4. Twilight will automatically give the light a power. This power can be changed manually using the Light Editor Dialog later.

5. After placing a light, right-clicking on the light will give you two options: Edit Light and Set Light Target.

6. Choosing “Set Light Target” will allow you to “re-target” your light quickly by clicking any point in your model. This works with IES and Projector Lights as well, but may reset any previous custom rotation.

7. After placing a light, open the Light Editor Dialog and use the eyedropper tool to choose and edit any light in your scene.

   If you see black speckles in your renderings it can be due to the fact a light is sharing 3D space with an adjacent face. For a 'standard' sized light bulb, keep the Omni Light approximately two (2) inches (5cm) away from adjacent geometry. If you change the radius of your Omni Light to be greater than two (2) inches (5cm), then move it even further away from adjacent geometry to avoid potential conflicts/light artifacts.

   Place an Omni Light into a light component fixture you have in your scene. Placing a light within a SketchUp Component will cause the light to adopt the component's name. In addition, when you copy the fixture the light goes with it. Also, if properties for an omni or spot light placed inside of a component are edited once, it will change the light inside all instances of that fixture allowing control of many lights at once.

   Twilight places all Omni (Point) Lights and Spot Light Components on the layer called “TWL_Lights_Layer”. This is so that one can easily hide all the lighting components from within SketchUp's Layers Dialog. Hiding a layer containing lights effectively turns those lights off when rendering in Twilight.

   After placing an Omni Light component into your scene, if you copy it to another place inside your model, you need only change its properties in the Light Editor Dialog once, as all other copies of that light will change with it.
Section 3: The Spot Light Tool

The Spot Light Tool allows you to insert a Spot Light. A spot light is manually adjustable to cast light in a certain direction with a definable "Hotspot" angle and a "Falloff" angle.

To place a Spot Light in your scene:

1. Click the Spot Light Tool

2. Click your light's Basepoint (the place in your scene on a face or point near where you want the light to be placed) (drawing a temporary line where you intend to place the light may be helpful for guiding placement of a light, for example a line crossing a circle so you can snap to the midpoint of the line with your light.)

3. Now you need to click a second time to place the insertion point of the Light Component. To avoid lighting artifacts or problems, the component must not be touching an adjacent face. Moving the mouse in a direction you can specify the insertion point for the light itself. Use the Shift key to lock the inferencing, just as with many tools in SketchUp. Now click to place the Spot Light Component or type a distance.

4. Click a third time to place a Direction Point, this is how to “point” the Spot Light in a certain direction.

5. Twilight will automatically give the light a power. This power can be changed manually using the Light Editor Dialog later

6. After placing a light, right-clicking on the light will give you two options: Edit Light and Set Light Target.

7. After placing a light, open the Light Editor Dialog and use the eyedropper tool to choose and edit any light in your scene.

If you see black speckles in your renderings it can be due to the fact a light is sharing 3D space with an adjacent face. For a 'standard' sized light bulb, keep the Spot Light approximately two (2) inches (5cm) away from adjacent geometry. If you change the radius of your Spot Light to be greater than two (2) inches (5cm), then move it even further away from adjacent geometry to avoid potential conflicts/light artifacts.

Place a Spot Light inside of a light component fixture you have in your scene. The Spotlight will automatically adopt it's name from the component. In addition, when you copy the fixture the light copies with it. Also, if properties for an omni or spot light placed inside of a component are edited once, it will change the light inside all instances of that fixture.

It is with a Spotlight that one may utilize Photometric (IES) data. Load a Photometric Data File (IES) into the spotlight's definition by choosing the IES tab in the dialog and clicking the Load button to browse to and load the IES file. IES files are found for light fixtures, not for bulb types. They are provided by most commercial lighting manufacturers for free on their websites.

To Convert an Omni into a Spot light, choose the Omni Light in the Light Editor Dialog and click the “Convert” menu item at the top of the dialog. Choose “Spot” to convert the Omni into a Spot Light, then it will be able to be loaded with IES data.
Section 4: The Light Editor Dialog

The Light List and Settings (+Sky) is a listing of all lights in the scene, allowing easy access to full lighting control. This is also where you can choose Sun & Sky parameters as well as utilize an HDR or Spherical Sky.

The Sky contributes to lighting in most rendering methods* in Twilight. This is why the sky is found in the Light List and Settings Dialog. The Sun & Sky work hand-in-hand by default in Twilight with the Physical Sky setting.

*specialized render methods do not take sky light into account such as Alpha Mask or some other render passes. Also, simple raytracing method is possible with Twilight, and sky light is not taken into account with this method.

Using the “From Scene” Pull-down Menu you can choose from a list of all lights in your scene to edit. Choosing “All Off” will disable all lights, including the sun. It will NOT turn off the Sky. To disable the sky, simply choose “Background Color” as the Sky Type. Backgrounds will not contribute light to the scene.

**Standard Light Options Tab**

Naming lights is important for good scene organization and for ease of the next user to find what they are looking for.

“Enabled” check box turns the light on or off.

“Casts Shadow” check box only works for lights when rendering with non-progressive rendering methods such as the Low-High render presets.

“Soft Shadows” check box turns the soft shadow on or off. Realistic lights usually have soft shadows.

Light Color box will accept RGB values as well as the common color names. Clicking the color swatch button will pull up the Color Swatch dialog.

Light Bulb Size is a radius size, so type accordingly. This controls not only how the light will interact with adjacent geometry, but also the soft effect of the soft shadow. The larger the radius, the softer the shadow.

Light Strength: With IES Data Files, the light strength should be set to a power of 1. Light Strength and hotspot/falloff information for spots play crucial roles.

The Attenuation is the amount a light will dissipate. In physics this is typically by the Inverse Squared.
Spot Options Tab

Spot Lights have (2) two main parameters, the Falloff, and HotSpot.

**Falloff**

Falloff defines the angle which the light will “Fall Off” from full strength to zero. It starts at full strength from the angle defined in the HotSpot. It fades to zero using the angle defined in the “Falloff” parameter. Therefore the Falloff angle must be greater than the HotSpot.

**HotSpot**

HotSpot defines the angle through which the light will remain at its full power. Outside of this angle, the “Falloff” will begin.

IES (Photometric) Light Options Tab

After loading an **IES Data File**, the spotlight's component will change shape in an attempt to approximate the direction and strength the light will shine. The smaller the 'leg' the less light output from that area of the light. This allows the user full control for easily placing the IES light and orienting it correctly.
**Projector Light Options Tab**

A Projector Light allows you to load a .jpg image into the light definition so that the light will actually cast the image onto a surface. This is useful not only when rendering an auditorium or classroom space where a projector might be displayed but may also be used for special lighting effects.

1. Convert a Spot or Omni into a Projector using the Convert Menu.
2. Click Texture button on the Projector Tab and browse to the image.
3. Light color will be automatically set to BLACK. (Any other color will tint the image)
4. Width and Height proportions of Light will be automatically set to match image dimensions. Projector Light Component Shape will update accordingly.
5. Name the Projector Light using the Standard Tab.
6. Increase Power of light to increase “Brightness” of image, and use Exposure on the camera tab.
Sun & Sky Options Tab

The Sun & Sky Options Tab gives full control over the environment. Here it is shown “out of the box” with all the default settings. The default settings should work for most cases. Here is where you can “turn off the sun”. The sun is enabled for your convenience whether or not the shadows are turned on inside of SketchUp. This allows one to work on larger models with the shadows off in SketchUp, but still have them on when hitting the render button.

Background/Sky Type:

Choose the desired sky type from the Background/Sky Type menu:

1  **Physical Sky**

Default to start, as it changes with the time of day and location set in SketchUp. Physical Sky also contributes good lighting from all directions onto the model.

2  **Background Color, Centered Image, Tiled Image, Fit Image** (These options will NOT contribute light/reflections)

These options give the least control over placement of image, and do not contribute as lighting from the sky nor to reflections. All of the background types only display a “background” in front of the camera. The “sky” behind the camera is therefore black. It is best to avoid using them, they are provided for artistic freedom purposes for advanced users.

3  **Sky Color**

is best to use when wanting a single color projected onto the scene from all directions. Light Grey works well as a quick “soft box” for product shots. It contributes to both scene lighting and reflections. It also looks great with the clay rendering settings.

4  **Hemispherical Sky and Spherical Sky**

Insert an image that is meant for use as a spherical sky or hemispherical sky (upper half only of the sphere). It contributes to both scene lighting and reflections. To use, Choose “Spherical Sky” then Click the Texture button to load the Spherical Sky image.

5  **Sky Probe**

This is for HDR images that are mapped specifically as a spherical “probe”. They look like a circle (see Fig.2). It contributes to both scene lighting and reflections. A “Probe” image will be identified as such on the web page where it is downloaded. If an HDR is loaded as a Sky Probe (or vice-versa) and it is NOT a probe but a Spherical Sky instead, it will result in odd lighting for the scene. Simply change the Sky Type to be the appropriate type and re-render.
Section 5: **The Material Tool**

The Material Tool allows you to quickly apply physically accurate material properties to any SketchUp material painted on a face in your scene. Good materials are key to a good rendering. With Twilight's Material Tool it is easy to convert your SketchUp materials into good materials.

With Twilight you are not creating "new" materials, but modifying the materials you already have painted in SketchUp. Hi-res textures applied in SketchUp are automatically optimized by SketchUp for quicker display while working, but the hi-res texture linked to the material will be passed through to Twilight and used for rendering. If there is no material applied, it can not be edited with the Material Tool.

It is important to note that the “Default” material in SketchUp will render as flat white. In order to edit the Default Material with Twilight's Material Tool you must paint the surface with a color or texture.

**The quickest way to paint all Default Material faces** inside of a SketchUp model is to choose a color or texture in the SketchUp material editor, then while holding the **Shift** key paint any Default Material face. All faces with the Default Material in the model will be now painted with the new material. To do this for only the faces connected to the face chosen, hold the **Ctrl** key while painting a face. (Caution, doing the “Shift-paint” option WILL paint all groups and components in the scene as well, and should be avoided when these are present in the scene.

**To copy a material from one surface to another**, while the Twilight Material Eye Dropper Tool is activated, Hold down the shift key, click-and-hold the mouse button down on the surface of the material you want to copy, drag the mouse to a face painted with the material you want to over-write, then release the mouse button. This is handy for dragging materials one likes from different past models into a new model.

If you are having trouble getting your material to work, refer to the Twilight Material Appearance Priority Order

---

**Material Previews**

There are several previews to choose from in Twilight. Clicking the pulldown menu under the preview image will allow you to choose from several spheres in different lighting studios, as well as cubes with different sizes for previewing architectural materials.

Spheres work best with materials without textures, such as glass and metal. While the cubes work best with texture-driven materials like stone, wood, and other patterns with real-world dimensions.

The size of the texture you see rendered in the SketchUp view window should be exactly what you will see in your rendering, so remember that the Preview Scenes are only approximations and actual render results depend on many complex factors.

There are two (2) ways to apply Twilight's Material properties to SketchUp's™ materials, [Material Templates](#) and [Material Libraries](#).
Material Templates

Material Templates are the quickest and most flexible way to apply Twilight Material Properties to SketchUp Materials. Therefore it is recommended to utilize templates whenever possible (in lieu of using Material Libraries). Some features of Twilight's Material Templates:

1. Template's flexibility allows you to create almost any material extremely quickly and easily
2. Templates share seamlessly among all Twilight users
3. Templates are guaranteed physically accurate unless specifically designed and stated otherwise
4. Templates will not increase a model's file size
5. Templates eliminate the need for project specific libraries, and reduces the chance of missing textures.

How To Apply a Twilight Material Template

Click the Twilight Material Tool, then choose a material in your scene you would like to add special properties to. Then apply a Template by choosing one of the Template names from the Material Tool's dialog Template Pull Down Menu. Materials are demonstrated most easily and quickly in the Getting Started Video Tutorials #1, and in the Intermediate Video Tutorial #1.

When to use a Material Template

Use templates to create a mirror, add reflection and bump mapping to ceramic tiles, add reflections to porcelain, add light emitting properties to any surface in any color, to create a translucent material such as wax, to create water or frosted glass or blurry metal like stainless steel.

Do NOT use templates on any material that does not need special properties, like reflection. Adding special material properties unnecessarily will only add render time with little or no visual gain.

Adding reflections (especially soft or “blurry” Specular Reflections) will drastically increase realism in a rendering as most materials, even brick, display specular reflections, but be aware that it will add render time and requires higher quality render settings to look correct.
Material Dialog Terminologies After Applying a Material Template

In order to help make modifications to the material, here are some explanations of terms.

Color Channel

There are three main “Channels” for most materials in Twilight. The first and “Main Channel” of the material in most cases is the “Color” of your material. This is also known as the “Diffuse Color”. “Color” can technically be a “Color” (an RGB value) or a “Texture” (an image). This is the “Color” or “Texture” of the material when viewed in purely flat indirect light. To choose a correct color, imagine what color the material is on a completely overcast day. In fact, to create your own hi-res textures, you want to take hi-resolution pictures of your textures with the most flat lighting possible, such as on a very cloudy day.

For this reason pure white should not be used as a “color”, as it should have “room” to be whiter when light shines on it. In addition, pure black should not be used, as it should have “room” to be darker when shadows fall upon it. There are no materials occurring naturally that are pure white or black. For white, it is recommended to use 90%-95% gray. For black, it is recommended to use 10%-20% gray.

Reflection Channel

The Reflection Channel is the color you see when bounced off of the surface of the material. It is advisable to leave the reflection color white. To reduce the amount of reflection one should reduce the shininess of the material or reduce the IOR. To create artistic effects adding a strong color here will create some interesting effects. See the Reference Section for an in-depth explanation about, Reflection Maps (using textures in the Reflection channel).

Bump Channel

See the Reference Section entry for Bump Mapping for an overview on the Bump Channel. See also the Material creation examples below.

Alpha Percentage

“Alpha” means the transparency or “see-thru-ness” of the material. This is directly linked to the alpha slider in the SketchUp Material Editor panel. So if you change it in the Twilight Material Editor panel, you will see it changed inside of SketchUp as well. "0" (zero) = completely transparent, "100" means completely opaque. It does not control the reflectivity of the object, only whether you can see thru it or not. If a Texture contains an Alpha Channel it will be automatically read/loaded by Twilight. Alpha Channels are automatically recognized by Twilight for the following image types: .tga, .tif, .png, .psd

IOR (Index of Refraction)

IOR may be the most obscure of the most commonly used settings. IOR defines how light is effected when passing through or reflecting from a material. For Glass this is a scientifically known number of 1.52. For water it is 1.33 (depending on the temperature).

For most surfaces, this is a scientifically known number, and also is automatically assigned by Twilight whenever you apply a template. So, in most cases, it will not need to be changed manually. If you know the IOR for the material you are trying to create, it must be entered correctly for the material to appear physically accurate. If not known, it's best to choose the template most similar to the type of material you are trying to create. For many materials a good starting template is the “Plastic” Template. There are many Refractive Indexes available on the web. A very nice one is located at: http://refractiveindex.info/
Shiny / Shininess
Surfaces that are very "smooth, or polished" are considered to be "shiny". (This would be like a Mirror, for instance.) Large numbers here = "smooth" (50000=perfectly smooth). Small numbers here= "rough". (7=lowest recommended value)

So for most objects, like a typical varnished wood floor, start by picking one of the plastics templates to start, (Flat, Satin, or Shiny). Increase or decrease shininess number as desired.

Hard Edge Angle

Hard Edge Angle is the angle between the normals of two adjacent faces. Hard Edge Angle is ignored if "Weld Vertices" box is not checked.

Welding vertices means you want to find all pairs of vertices with N distance of each other, and join them into one.

A "normal" is an imaginary line drawn perpendicularly out from the "front" of a face. It is used to decide which edge between two faces should appear smooth, and which should appear as a crease, or sharp. This only comes into play when "weld vertices" is chosen.

This is important also with the rendering of Edge Lines correctly on curving surfaces, because the vertices of a model for materials on curving surfaces will need to be welded, and this requires that a hard edge angle chosen. "30" is a good angle to choose to start as the smooth angle in most cases with default SketchUp curves.

Combine Hard Edge Angle with Edge Lines when working with Edge lines on curved surfaces... if not, the edge lines will show on each facet of the curved surface.

Edge Line
Checking the Edge Lines box will render lines similar to the edge lines you see in the SketchUp view. Edge Line thickness in Twilight is not linked to edge line sizes in SketchUp. To define edge lines use a simple rule of thumb:

Lonely Edges can not be rendered. That is, an edge that does not define the edge of a face will not be processed by Twilight. To render a "Lonely Edge" simply make it into a face by using a free ruby plugin for SketchUp such as "Extrude Lines 2 Points.rb" which may be found at the [Ruby Library Depot maintained by Didier Bur](http://rubylogic.com). Using this tool you may extrude the line a small distance with 2 clicks, such as ¼in (3mm). Then the line will render with Twilight's Material's Edge Lines feature. (try this technique with an imported CAD site plan)

.1=.1 meters = approximately 4” use this for large exteriors such as large buildings or interiors of very large spaces.

.01=.4” use this for fine lines around smaller buildings such as a house and elements like stairways

.001=.04” Use this for fine lines around detailed elements such as furniture objects and cabinetry.
**Material Template Choices Overview**

1. **Generic**
   Use this template to give a quick touch of reflection to a surface. This template is designed to be quick, but not necessarily the highest quality nor physically accurate. So use it wisely. Use this template also to reset a material. Sometimes it is quicker to just 'start over'. Here you will find the reset button for any material.

   *These material templates are by nature not physically "accurate" but are useful for many artistic applications. If you are experiencing strange lighting artifacts in your renderings, be sure to eliminate the use of any of these.*

2. **Paint**
   As its title suggests, if you have a surface painted the color you want in SketchUp, simply choose your paint finish here. Using a seamless texture for noise in the bump channel with the paint template can add much realism.

3. **Stone**
   This template will not apply any image of stone, but if you have painted a stone material onto a surface in your scene, choosing this template will make it look great.

4. **Ceramic**
   This template will not apply any image of tiles, but if you have painted a ceramic tile material onto a surface in your scene, it will give it the properties of a ceramic tile. Then you need only add a bump map or simply click the chain link icon next to the word “Bump” to link the SketchUp material into the “Bump Channel” Twilight material definition. See also more on Bump Maps. Using a Reflection Map to eliminate reflections on the grout joints will add much realism.

5. **Plastic**
   Many materials we see every day have a lot in common with plastic. A wooden floor, a table top, furniture surfaces, etc. This is a powerful template setting up your material so that you can set the precise reflection type and Bump Maps and Reflection Mapping you wish.

6. **Realistic Glass**
   If it's Realistic Glass you wish for, you must build the model accurately/realistically/to proper scale. If using the Realistic Glass template, be sure the model you apply it to has a thickness and can 'hold water'. That is, that it is a 6-sided cube, a valid solid, if using a rectangle in a model of a glass table top for example. One should also always be certain that the Normals for all Faces on realistic glass models are facing “out” as the normals are used for calculating much about the light passing through and bouncing from this surface.

7. **Architectural Glass**
   The fastest rendering and best looking glass for most architectural renderings will be found in this template. For the quickest architectural renderings with glass, draw a single face to represent the glass surface, paint this face with a glass material from SketchUp, and then apply a choice from this template to that glass material. When using a non-progressive rendering method the template without shadows will render very quickly and allow the most light to enter an interior room. Set IOR to 2.2 and change color of reflection to darker grey for a “tinted” glass look.

   *These material templates are by nature not physically "accurate" but are useful for many artistic applications and render nicely in all methods.*
8 Metal

Making a great-looking metal is as simple as a click here. After applying a template you can change the color, shininess, reflection color, bump mapping, etc. to make it look however you like. Remember that metals will look great in Twilight, but require high render quality and may take a long time to render nicely. Using an Easy Render Setting with a “+” sign will bring nice results.

9 Brushed Metal

Looking for a brushed stainless steel? Look no further. Aluminum, or other brushed look metals can be based on these Templates. Remember that metals will look great in Twilight, but require high render quality and may take a long time to render nicely. Using an Easy Render Setting with a “+” sign will bring nice results. Look also to the “Alternative_AA” methods in the Express>Advanced Render Settings folder. Progressive render settings will bring best results.

The key with many Templates is to use the SketchUp texture only in the bump channel.

To do this after applying the Brushed Metal Template>Aluminum to the “Cladding_Siding_White” SketchUp Texture:

1. Click the Chain Link Button to break the link of the SketchUp Texture Image to the Material Color Channel.
2. Click the Chain Link Button to enable the link of the SketchUp Texture Image to the Bump Channel.
3. Click the Texture pull-down menu choice in the Material Color Channel and choose “Color” to remove the texture completely from the Color Channel.
4. Now the SketchUp image is driving the bump instead of the color.
5. Adjust the metal color further by changing it in the color channel, change the shininess to 20 to make it even more 'brushed' and matte-looking... maybe go even to 7. You can also add a color to the reflection channel to create other types of metal. This material will continue to remain physically accurate (obey the laws of physics).

For instance, use this method (without Click-3) to create ceramic tiles by combining a SketchUp Ceramic Tile Material with a Twilight Ceramic Template, or create concrete by combining SketchUp’s Concrete material with the Rough Stone Template, or SketchUp’s Wood Flooring by combining it with the Shiny Plastic Template.

Be sure to add a scratch map to your bump texture (create a seamless scratch map using an external photo editor, or download a great one for free from the Twilight Render forum.) This will give a more realistic looking Brushed Metal because the scratch look is not added automatically. A scratch map looks something like this:

To create a Zinc metal using the Brushed Metal Template

Apply the Brushed Metal Template>Aluminum, set the Color to 90% grey, set Shininess to 15.
To Create a Good Brick Material with Twilight Material Templates

For bricks, start for example by applying SketchUp's "Brick_Rough_Dark" brick material in the "Bricks and Cladding" SketchUp material category.

1. Apply Template "Stone>Natural" Template with Twilight's Material Tool.
2. Click the Chain Link Button next to the Bump Channel, this links the image of the brick to the Bump Channel, driving the "Bumpiness" with the image of the bricks.
3. Check the Invert box next to the Bump Channel. Inverting the image makes the joints appear darker than the brick which is essential for correct Bump Mapping in renderings.
4. To get a more 'bumpy' effect, increase the “Size” number of the bump from “1” to “2” if still not enough, increase it to “3”. Bump over “3” usually becomes distorted, not attractive.
5. Change the “Shininess” from the default “20” to “7” to get a very subtle soft reflection. Shininess lower than 7 generally will not give good results.

10  Fast*

These materials may be the place to turn when lower quality settings are required for speed. If using “Medium” settings, but the Brushed Metal requires higher setting, try “Fast Aluminum” (modify color as desired). It will render much cleaner in that setting than the highest quality metals will.

*These material templates are by nature not physically “accurate” but are useful for many artistic applications. If you are experiencing strange lighting artifacts in your renderings, be sure to eliminate the use of any of these.

11  Light Emitter

Another way to create truly realistic light sources is with a Light Emitting Surface (LES). Paint your surface with a color (white), and apply the Light Emitter template to that color to make it shine. Remember that great light comes at a cost of render time and that higher quality render settings are required. It is recommended to use LES only with progressive indoor rendering methods. Each light emitting rectangle is considered as two (rectangles are divided into triangles during processing in order to be rendered with Twilight's engine. Therefore turning a sphere into a Light Emitting Surface could result in Twilight's engine thinking about hundreds of little “lights”. Use Light Emitting surfaces wisely.

After applying the Light Emitter Template you can see a new parameter appear called “Emitter”. “Fake” makes it 'look' lit, but it will not increase render times as it does not actually shine any light when rendered with a non-progressive rendering method. Fake Emit is great for making a quick-render TV screen material. Or good for inside of a light fixture where no actual light may be shining. Invisible makes it so that it will shine light, but not be visible in the rendering as the light source. You may also choose to load an IES Data File into a Light Emitting Material with this pull-down menu.
SubSurface Scattering is the phenomena of light “scattering” along/underneath the surface of a material causing a “glow” in some lighting conditions.

A good example is a piece of translucent plastic covering a light fixture, jade stone, or a wax candle.

SubSurface Scattering can require higher quality render settings to look satisfactory. They will not show up correctly at all in Easy 01 Prelim or Easy 02 Low. Using an Easy “+” setting will give better results. Using Progressive Rendering methods will guarantee good results. Easy 09 will give the best results only when using Light Emitting Surfaces or HDR lighting. Easy 10 will give the best results in all lighting conditions. SubSurface Scattering template will not typically render correctly on a single face. The model must have a real-world thickness and follow similar rules to modeling for using the Realistic Glass Template. Most importantly, the model must be a valid solid that is water-tight, and be of accurate scale.

To use the SSS template:

1. Apply a SketchUp Material Color to your model,
2. Apply an SSS Template to that material.
3. Set Alpha Opacity and SSS Density for the material as desired.
4. Change color of material as desired. (It is recommended to leave Reflection Color set to White)
5. Be sure lighting in the scene will display the SubSurface Scattering property of the material. Direct flat lighting of the object will not render this property well. Note the back-lighting in the examples to the left.
If you can not seem to get what you want from the Templates, the material libraries can be a huge help.

There are several useful libraries installed by default with Twilight. Gems, Translucents, SubSurface Scattering, Illuminants, and more. These are libraries of materials that may be difficult to achieve any other way. They were created and provided by various contributing artists and are used/distributed with permission for Twilight Render. Additional content for Twilight such as Materials, Skies, and Components can be found by Licensed Users in the “Red Carpet Club” section of the Twilight Render User Forum.

There are hundreds of high quality free materials available for free download from Kerkythea.net. Users of Kerkythea may also create their own material libraries using Kerkythea, then either point Twilight to the Kerkythea Material Libraries folder via the Twilight Options Dialog, or copy a library folder from the Kerkythea Material Libraries folder into the “…SketchUp\Plugins\Twilight\Materials” directory.

To install a material pack

To install a material pack downloaded from Kerkythea.net for use only with Twilight Render:

1. Change the name of the file from “Example.mat.zip” to be “Example.zip”.
2. Unzip the file into your “…SketchUp\Plugins\Twilight\Materials” directory.
3. Re-open SketchUp to see it in your Library List.
Section 6: The Twilight Options Dialog

The Options For Twilight dialog allows you to set various default background parameters and file paths for Twilight.

**Directories and Files**
Specify here any directory (i.e. network directories) for Material Libraries, Material Preview Scenes, and Rendering Presets by clicking the Browse Button.

**Dialogs**
Reset all your dialog answers, or Restore or Reset all Dialogs to their Default Positions. Show the system log file (if having an an issue with an error). You may Choose different Themes for Twilight’s User Interface.

**Advanced**
If you prefer to specify the filename for your image every time before you render, choose it here.

**About**
Gives information about specific version of Twilight being used, registered user information and other credits. This is also where one may Request a License and Install a License.

In order to create a license request:
1. Push the Request License button.
2. Save the generated file.
3. Email the file to licensing@twilightrender.com.
4. Then someone from Twilight Render LLC. based in U.S. Mountain Time Zone will generate a license and email it back within 24 hours.
5. Copy the text of the license number from the email.
6. Push the Activate Twilight button.
7. Paste the text of the license number on line provided.
8. Copy the Activation Email address from the email.
9. Paste the text of the email address into the box.
10. Click Ok.

**Twilight Language**
Choose your language, close the dialog, close and re-open SketchUp. Refer to your operating system help for correct language pack installation.
Section 7: Position Scene View Tool

The Position Scene View Frame

After clicking the Position Scene View Tool, a 9 square grid will appear. This helps with framing a view using the “rule of thirds”, typically putting the subject at or near the crossing of the third points adds interest to the scene. When the “The outer edges of the grid are the outer edges of precisely the view that will be rendered.

Focal Point Center Axis

A secondary Red/Green/Blue axis of dashed lines will also appear in the scene to represent the center for the position of the Focal Plane. The Focal Plane is an imaginary plane that is perpendicular to the camera and represents the distance of the camera’s focal point from the camera’s lens. A camera’s focal point will always be on the Focal Plane in the center of the view. Now after choosing any point in the view as the focal point, this axis will update to show where that Focal Plane actually is in 3D space.

Rotation / Orbit of the View

After clicking the Position Scene View Tool, clicking on any point on any object in your scene and dragging the mouse will orbit the view about that chosen point.

Pan the View

After clicking the Position Scene View Tool, holding down the Shift key while clicking your mouse button and dragging will pan the view on that chosen point.

Look Around (Swivel the Camera)

After clicking the Position Scene View Tool, holding down the Alt key while clicking your mouse button and dragging will swivel the camera as if it were on a tripod. (Similar to SketchUp’s native “Look Around” tool)

Focal Point

After clicking the Position Scene View Tool, holding down the Ctrl key while left clicking a point in the view will align the Focal Plane represented by the camera’s Focal Point Center Axis with that object in the scene without visibly changing the camera's view in SketchUp. Holding down the Alt + Ctrl keys while clicking on any point in the scene will actually swivel the camera to focus on that point while setting that point as the new Focal Point for the camera.

Remember to create a new scene or update the current scene in order for SketchUp’s scene tab to “remember” your new focal point.
**Batch Rendering**

Batch Rendering is the process of Rendering Multiple Views but only clicking the Start Render button once.

To Batch Render with Twilight, utilize the Animation feature.

Example with 3 scenes to render, CamA, CamB, CamC.

1. Set SketchUp’s Animation Transition Time in Seconds to (1). (Window>Model Info>Animation)
2. Set SketchUp’s Animation Scene Delay Time in Seconds to (0). (Window>Model Info>Animation)
3. Specify these settings in Twilight’s Render Dialog Animation Tab
   - Start=(0)
   - Stop=(2) (the easiest way to think of this number is “the number of transitions between scenes”)
   - Set Frame Rate to (1)fps
4. Specify a Base Name for the rendered image files.
5. Twilight will render 3 frames: Frame000 = CamA   Frame 001 = CamB  Frame002 = CamC

**Background Images On “Billboards” or a “Plane” (Face) In SketchUp**

This tip contributed by Miguel Lescano Cornejo

Some people prefer to place a Background Image directly on a face inside SketchUp. Also, you might want to add images to TVs and computer screens. In all these cases, the inserted image needs to render exactly as it is, without being affected by the sun, sky, or lights in your scene.

The following setting works perfectly for Camera Tab Exposure Settings:

- Exposure = 1.0, Gamma = 1.0:
  1. Explode your image so it becomes a texture applied on a plane.
  2. In the Twilight material editor, choose Templates > Light Emitter, any of them
  3. Set the Power (W/m2) to 150.
  4. Next to the light bulb, Change Emitter > Normal to Emitter > Fake.
  5. Unmark the “Cast shadow” checkbox.

→ Your material settings should now look like this example to the left.

If you’re using a different Exposure value, use this simple formula to calculate the power for your fake emitters: **Power for your fake emitter = 150/exposure²**

Examples:
For an exposure value of 0.5, you must set your fake emitters to 150/(0.5)² = 600.
For an exposure value of 1.2, you must set your fake emitters to 150/(1.2)² = 104.167
For an exposure value of 2, you must set your fake emitters to 150/(2)² = 37.5

In all cases, you need to keep a gamma of 1.0 if you want your images to render unaltered.

As a note, the "no shadows" and "fake" settings do not work when using render setting Easy 09 or Easy 10. These render methods do not allow the ‘faking’ of light effects.
Bump Mapping and Bump Maps

Using a Bump Map allows a render engine to use a Grey Scale Image to create an illusion of geometry that is not actually there. Bump Maps do not create geometry (i.e. displacement) Bump Maps only work on surfaces that have some measure of reflectivity. They will not really be noticeable on a flat colored surface.

Bump Maps work like this: 50% Grey = "no change" in appearance for the height of the surface. Darker = "in" or "down", Lighter = "out" or "up".

The easiest way to apply a Bump Map in Twilight is to first, apply a template similar to what you are trying to create. If it's painted metal, use a "paint" template. If there is no template applied, increase the IOR number from the default of "1" to be something higher, i.e. "1.1". If the IOR is not increased, the bumps will not appear. Second, click the Chain Link button next to the Bump Map slot. This links the image of the material into the Bump Map slot.

To assign a Bump Map in Twilight after assigning a Template:

1. Choose “Texture” in the Material's Bump Slot
2. Browse to and load the Bump Map texture image.
3. Set the “Size” or “Strength” of the bump. A size of “1” or Less is appropriate for a good bump map. When linking the bump texture to the SketchUp Material, it is suggested to keep this number to “3” or less.

In the case of a Brick Wall image, for example, if the bricks are light and the mortar lines are dark, it will work well as a Bump Map. The dark mortar will enhance the depth when in the Bump Map Channel. If the bricks are dark, and the mortar lines are light, using the 'invert' check box for the Bump Map Channel will allow you to quickly invert the lights and darks of the image in the Bump Map Channel, making the mortar lines recede "in" to the wall and the bricks bump "out". This method works well in most cases, but in some cases, will not give satisfactory results.

The best way to apply a Bump Map is to create a True Bump Map. A True Bump Map is actually made specifically with the Bump Map Channel characteristics in mind. (Dark = "in/down" Light = "out/up") Open the image file you want to use as a base for creating a Bump Map into your preferred image editing program, such as Adobe Photoshop. Duplicate the layer, turn it to grey scale, increase contrast, and paint areas 50% grey where you want no bump. Paint areas black where you want the deepest recesses, and vice versa. This was done for the bump map for the Wood_Bamboo_Medium flooring example in the image above.
Codec

A Codec is used during processing of an animation using a separate video editing program such as Windows Movie Maker, or the free and easy-to-use VirtualDub. Using a Video Editing program one may open a series of .jpg images, just as rendered from Twilight, and save them as an .avi video. Using a Codec allows the program to compress this .avi video resulting in a much smaller file size.

It is important to remember that many codecs require a certain size or image proportion in order to be used. For example, when using the Xvid codec, the Width of the image must be divisible by 4 and the height must be divisible by 2. Paying special attention to the size of the rendered image for animations therefore becomes critical in post-processing.

Color Codes - RGB, HEX

Twilight will accept common English names for colors, (i.e. [White], [Yellow], [Brown], etc.) It will accept RGB colors typed in this format: [rgb(62, 91, 5)]. It will also use HEX codes in this format [#704E32] when pasted into the color line. Use of these formats apply for all Twilight Dialogs where a Color Code can be used.

Custom Material Templates and Material Libraries

“If I spend time to modify a Twilight Material Template to get something I want, can I save that as a Custom Template?”

Saving the SketchUp model saves the settings. But there is, for the moment, not a way to simply save a template setting for reloading later. You may attempt to modify an existing template using a text editor. There are several alternatives:

Option 1: Leveraging Components

1. Create a component with a face that has the SketchUp material using your Custom Template Settings. i.e. “Water1” It is important that the name for your material you want to use be unique from the default SketchUp Material names, otherwise the imported material will be overwritten by any similarly named material already within the scene.
2. Create a personal Component Library in the SketchUp/Components folder, and call it something like “Twilight”.
3. Save the component “Water1” containing the specialized “Water” material into your “Twilight” components folder.
4. Start a new scene and insert the “Water1” component from your newly created Twilight Library.
5. The material definition is now in your scene.
6. Using the alt key with SketchUp’s paint bucket tool you can sample the water from the inserted component, and paint it on other surfaces around the scene.
7. Another alternative is to Shift-drag the material from one surface to another using the Twilight Material Eye Dropper Tool.

Option 2: Leveraging .skp Models/Scenes

Save a simple “storage” model somewhere on your hard drive. Call it “MyTwilightMaterials.skp”

- When you have a material you like in Twilight, copy a face containing the material from your model and paste it into your “MyTwilightMaterials.skp” model.
- Then when you need the material, you can open the “MyTwilightMaterials.skp” and copy that face and paste it back into your new model, then shift-drag the material onto your current model as described in Option 1 above.
Option 3: Create a Custom Material Library for the Scene Using Kerkythea 2008 Echo.

1. Export scene to Kerkythea.
2. Open the Material Editor.
3. In left pane select and right-click the material(s) and send the Scene's Materials to the right pane.
4. Save Material Library / give it a name.
5. Use Twilight's Options>Files&Directories panel to add the new Material Librarie's path location. You will see the Material Library of Kerkythea upon re-opening SketchUp the New Material Library will be listed in the Twilight Material Libraries.
   -or-
6. Copy the new Library File from the Kerkythea/Materials/Libraries folder into the Twilight/Materials folder.

DISADVANTAGES TO REMEMBER WHEN USING LIBRARIES:
In the setting of an office or network, when sharing a scene, the library must also be sent with the file. Library materials are 'dumb' materials, that is, they cannot be easily edited. Edge Lines do not work with Library Materials, unless they are created specifically to do so. Materials can of course be exported via .xml to Kerkythea, edited, and saved into a library again, etc.

Faceted Geometry of Curved Surfaces

If there is a curved surface that should be rendering smooth, but it renders as faceted, place the geometry within a group or component, and it should render smooth.

HDR

High Dynamic Range (HDR) images contain 32 bits of information per pixel as opposed to 8 bits with a .jpg. In rendering one typically uses a spherically mapped HDR image to actually project light onto a 3D scene from all directions at once. In this manner, if an HDR is created in a specific place (St. John's Cathedral, for example) and then used to light a 3D object, one should be theoretically able to visualize the object as if it were lit with the exact light that it would get in St. John's Cathedral. There are thousands of HDR images available for download via many different websites.

HDR typically provide all the light your scene needs. Exceptions would be in the case of using HDR images to light an Interior. It's better to not use sun in conjunction with an HDR in the Sky, but for artistic effect this is common practice. In this case changing (lowering) the power of the sun and/or changing the intensity of the sky, and/or lowering the exposure of the rendered image may be advisable.

In Twilight one also has the ability to save an image as an HDR. In this case, one would do so in order to have the ability to take advantage of the darkest and lightest areas of the image, where in a normal image some of these areas may not be able to be seen clearly, with an HDR one may tonemap them using a photo editor to get the greatest visual tonal range. Of course, if the Camera is set to Spherical, and the image is saved as HDR, you will have a spherically mapped HDR image of your model.
IES Data Files (.ies)

IES is a file format developed by IESNA a consortium of illuminant manufacturers and other Agencies. It contains manufacturer data and Photometric data that show the light distribution pattern of the illuminant, typically a specific light fixture. It is typically available from the lighting manufacturer's website alongside the other technical information for the light fixture. Download the .ies format text file and use the IES (Photometric) Light Options Tab in The Light Editor Dialog to Browse to the .ies file. Now the light object will emit light in a way that is specifically mimicking the light emittance for that light fixture. Be sure the power of the light is set to 1. To increase the brightness of lights, typically adjusting the exposure of the camera on the Camera Tab will do the trick. If the IES is surprisingly dim for some reason, it could be a poor .ies file, or it could be for a fixture with particularly low light output.

Light Portal: see Sky Portal

Light Through A Window:

You are rendering an interior and have sun coming through the window. Here are a few tips.

- Be sure all windows are only modeled with a single pane of glass.
- Be sure you have applied a material to the glass using SketchUp's materials, such as the typical "translucent_glass_grey" or whatever
- Be sure you use the Twilight Material Tool to click that glass material on the windows and apply the Architectural Glass>*Common" or "No Shadow"
- Set the sun in SketchUp to cast as much light as possible into your room... the more light the better.
- Apply material templates that are appropriate to your other objects.
- Render a small test render with Easy01-Prelim
- Adjust tone mapping exposure in the camera panel of the Render Window if image is too dark. (Typically will be too dark, try Exposure=1.7)
- When happy with camera, materials, etc. Render test render at 800x600-ish on Low or Medium easy settings.
- When happy and ready for the "final" render on Easy09 progressive. This will give you best results with so little light.
- Perhaps try using a Sky Portal: the Sky Portal Material is for use on models of interiors where they rely on the Sun and Sky.
Lighting An Interior Scene

First, Build reasonably accurate component for your lights. Insert a Twilight Light Object inside the Light Component. Put the lights in places and with powers that are equivalent to the way the space would be lit in real life.

Avoid fill lights, and fakery unless you know what you are doing... they typically add render time, and detract from the 'real' look of the final image... and may actually make the rendering simply 'over lit' and blown out, leading to SLOWER render times.

It's difficult to give a 'wattage' power to a spot light in Twilight. But for a rule of thumb, assume the default spot light is a 100w bulb in Lumen output. Lights don't emit "watts", they use Watts to emit light which is measured in "Lumens".

The closer the hotspot number is to the falloff number, the lower the light power will need to be, so a hotspot of 30, falloff of 31 can mimic a 100w bulb with a power of only .5 or something like that. For a hotspot of 10 falloff of 179 the power will need to be about 1.5 to mimic the behavior of a 100w bulb... just as a very general idea.

For the most accurate lighting with spotlights, insert a spot, set power to "1" and load the IES data for the fixture using the IES tab in the Twilight Light Editor. Rendering it in Easy 09 or 10 for interiors will be most accurate.

To calculate the power for light emitter surfaces is a bit more complicated.

Let's say you have a large space and you want to light it all quickly and evenly with just 2 lights. We just said above that we don't want to 'fake' lighting, typically, so what are we talking about here? Occasionally you will need to use some 'creative lighting' to render quickly yet still look good. So for your average space, just light it as is, but for a huge gymnasium with 200 light sources, there may be a better way...anything over 15 lights is considered a "lot" of lights for "Easy" render settings 1-8.

Create a plane below the ceiling. Hold it off from the side walls about a foot (30cm). Then paint it with white, and rename it "Emit" then apply the Template "Emit 100w/m2"

Select the face in SketchUp and look at the Entity Info to see how many meters squared it is, then go from there to figure out the power you want it to emit. If you want a total emittance of 1000 watts to light the entire space (large dining hall or airplane hangar), and your plane is 5540sqft(515sqmeters) and you apply the 100w/m2 light emit template, this will mean that the plane will emit 515m2x100w = 51500watts...

This is too much, so change that to what you want, and put that amount of watts you want it to emit. 1000w/515m2=1.942 w/m2. So set emit to 1.942 w/m2 for a 515 square meter plane to make it mimick the light output of an emitter powered by 1000 total watts.

Now your ceiling just became a 1000watt light bulb and equals 2 lights in Twilight because a rectangle will be triangulated, but because the light is in power defined by area, it doesn't matter the number of triangles, but rather the area.
Material Priority

In SketchUp there are so many ways you can paint things that there needs to be a priority order for rendering these materials. When painting objects keep in mind these important tips:

1. It is best to paint faces, not groups or components. It is best to paint Front Faces! Try not to paint back faces.*
2. If a group or component is painted with a color or texture, the FRONT faces in that component or group will acquire that color.
3. If a BACK face is painted with a color inside of a group or component, and the Component itself is painted with a different color or texture, the Face will render with the color painted on the Component, not the color painted on the back face inside of the component. This is different from how you see the colors displayed in SketchUp's view.

*The Back Face in SketchUp is by default a blue color. Avoid painting back faces because the normal for a back face will return the opposite information for materials for a bump or specular map than you want it to give. Also, if a back and front face are painted, the front face's material will be what you will see, not the back. So this will give confusing results in your rendering. Only paint front faces.

Model Processing Phase

The Model Processing Phase happens just after you click the Start Render Button. It is the part of the rendering phase when Twilight processes all geometry, components, lighting, cameras, materials, and animation information in your scene. Hidden geometry is not processed. Objects on a layer that has been turned off are not processed.

You can control what is processed from your scene in many ways:

1. Select an object and tell Twilight to render only that object
   1. Select the object you wish to render by itself.
   2. Click the Twilight Power Button to open the render dialog.
   3. Click the Start Render Button.
   4. Twilight will then ask you if you want to render only the selected object(s).
   5. Click “Yes”. This will then cause Twilight to render only the selected object(s).

2. Turn off a layer containing objects you wish to hide.
   1. It is wise in SketchUp to draw everything on the default layer (Layer0).
   2. This way if you wish to hide some objects (such as furniture, or Phase 1) you can create a layer (such as one called “Furniture” or “Phase 1”).
   3. Then, in SketchUp's Pull-down Menu “View” go to “View>Toolbars>Layers”.
   4. Now selecting an object(s) in your scene you can force that object onto another layer by simply going to the Layers' pull-down menu and choosing your layer (such as one called “Furniture”).
   5. Now open the SketchUp Layers dialog via SketchUp’s pull-down menu “Window > Layers” and uncheck the box next to the layer name holding the objects you wish to hide.
   6. Or simply go to Twilight's Render Window, and choose the pull-down menu “Layers” and deselect the name of the layer you wish to hide by clicking the name of the layer. This will leave it visible in SketchUp's scene view, but not render it.

3. Hide an object or group inside of Google SketchUp.
   Select an object and context-click (right-click), choose “Hide”. Or go to Sketchup's Menu “Edit > Hide”
4 Nested Groups, Components, or Objects on Hidden Layers

Putting High-polygon objects on hidden layers inside of components allows one to hide the layer while work, yet see the object when rendered. This is also known as one way of handling “proxy” objects. See full description in the Reference Section “Proxy Object, or, High Polygon Object Rendering/Handling in SketchUp.”

5 In the Advanced Tab you can set the processing to work only on lights and cameras.

Under the Content Updates : Update Method > Lights, Cameras.

If you have not yet already processed the entire scene once it will automatically do so. After that, each time a rendering is started, it will only change the lights and cameras, but the materials/model will be reused from the last rendering. This speeds processing greatly on large scenes after the full model has been processed once and you are working only on modifying lights or cameras and find yourself re-rendering multiple tests. When rendering architectural animations where the camera is the only animated object, there is no need to change this method on the Advanced Tab, simply choose “ViewOnly” in the Animation Dialog “Type” pull-down.

If you find you have changed geometry or materials, and they are not being updated in the rendered scene, be sure to check if this option is enabled. If so, change it to process “All” once again.

Multithreading and Rendering Machine Recommendations

Twilight will render in Multithread mode on most Windows computers running SketchUp or a virtual Windows set up for Mac users.

Threads = Number of Threads provided by your processor(s) to employ in rendering the image. Multithreading means that the computer is utilizing more than one Thread to do a task. Twilight will by default render with the maximum number of threads found on the machine.

However, computer prices are affordable today with machines available now that have processors that utilize a technology called “hyperthreading” that gives them 8 threads. This means it is affordable to have a machine that renders with high speed using Twilight on 8 threads at a surprisingly low cost. This same technology even makes each thread faster than one may expect. It is suggested for maximum enjoyment of Twilight that one do research before purchasing a machine for rendering. Affordable machines are now commercially available with 16 threads.

Post-processing (aka Post-Pro, or PP)

Post-processing is the action of editing any raw image after it has been rendered by a render engine (such as Twilight). Editing the image can be done with any number of photo/image editing programs such as the free program known as The Gimp, or the well-known Photoshop. To learn more about methods of Post-pro, simply search the internet for tutorials on the subject of interest. Twilight Render provides several hi-quality Post-pro technique tutorials on its forum.
Proper Animation for SketchUp by Morisdov (+ Mover.rb Animation Plugin for SketchUp)

This is an animation plugin for SketchUp that allows one to animate objects, such as the opening of doors, or moving of an object from one place to another. When used properly, it's animations will be automatically rendered by Twilight. Set up the Animation Options appropriately as described in the Animation Tab section of this manual. Mover.rb provided by CMD of the Google SketchUp Team is even easier to use and very handy for Animating objects within SketchUp for rendering with Twilight. Jim Folz has developed it further here with dialogs and easings.

Proxy Object, or, High Polygon Object Rendering/Handling in SketchUp

As of Twilight version 1.1 SketchUp's layers are handled on a WYSIWYG (What you see is what you get) basis. So any layer you see turned on in your SketchUp Scene should also be what is rendered in Twilight, and vice-versa.

Proxy Rendering is available in Twilight by leveraging the power of Layer Visibility in SketchUp. A “Proxy” is a “Stand In” for something else. A Proxy object in SketchUp is something you can see that represents “stands in for” something much more complex.

Try this workflow for working with High Polygon models that will be used more than once in your model, or with any model that will be used many times and slow down your work in SketchUp.

1. Geometry should be drawn on Layer 0, then select the geometry and turn it into a component.
2. That component should be placed on a unique layer called something such as “High Poly Object Layer”.
3. Now Create a bounding box around that High poly component and erase the faces so that there are only edge lines.
4. Turn the edge lines into a component and place that component on a unique layer called something like “High Poly Guidelines”.
5. Select the two components and create a new component called “My Combined Component on Layer 0”.
6. Now turn visibility OFF for the layer “High Poly Object Layer” using SketchUp's Layer Dialog Visibility Check Box. (Do NOT hide the geometry, it will NOT render!)
7. Then, select the component, one may choose “Render all Layers in Component” from the Right-click>Twilight Context Menu.
8. After changing a component to have it's layers rendered whether or not they are visible, you can set it back to “normal” by choosing the component again, Right-Click, then choose Twilight>Render only visible Layers in Component.

Note that if there is a smaller component located inside the larger component (known as a “nested” component), this choice must be deliberately activated upon all nested components. If you have enabled the “Render all Layers in Component” option for a component, yet something on the same layer within the component will not render, be sure to check if that object is inside of a nested component.
Reflection Maps (Specular Map)

Using a Reflection Map or “Specular” Map one can precisely control the amount of light reflected. Related to Alpha Mask, or Bump Map, the Reflection Map reacts so:

- Black = No Reflection,
- Gray = Percentage of Reflection
- White = Perfect Reflection

Combining a good reflection map with a good Bump Map will make extremely photo-realistic materials.

To assign a Reflection Map in Twilight after assigning a Template:

2. Browse to and load the reflection map texture.

RGB (Red Green Blue)

RGB are the Red Green and Blue values (numbers) used in order for a color to be displayed on a computer screen. An RGB value is written as: rgb(251, 190, 36) in Twilight dialogs. Other related ways to modify a color in SketchUp’s material dialog are by using the Color Wheel, HLS (Hue, Lightness, Saturation) and HSB (Hue, Saturation, Brightness).

For those experienced with rendering, and desiring more than Specular Reflection control via a “true” Reflection map, this is available in Twilight via Kerkythea Materials. Refer to the Twilight Render Tips, Tricks and More Forum for tutorials, including a video tutorial showing how to leverage Twilight with Kerkythea’s Material Editor.
**Scratch Map**

For Twilight Render the scratch map is simply another name for **Bump Map**. If you apply a brushed metal template to a color in SketchUp, for it to look "realistic" you will need a bump map that looks like the fine scratches in brushed materials. So applying a Scratch Map, in other words a grey-scale image texture with the look of scratches (see example image to the left), to the surface, and then applying the Brushed Metal Template to that material will result in much more realistic results. The scratch-looking bump map should be correctly scaled using SketchUp's native material editor and texture positioning tools. If you are using the Kerkythea Material editor a scratch map becomes a bit more complex/powerful. Kerkythea users should refer to Kerkythea's Materials forum and documentation for further information.

**Share a Twilight Render Scene with another user:**

Twilight Render Users on the same network should be able to open any SketchUp model and hit render. Just follow these simple guidelines:

1. Use .ies files and texture files that are available on a network location, not on a local machine.
2. Avoid using Custom or Special material libraries. It is highly recommended to use Templates when creating materials with special properties. When required to use a library material, try to use only library materials provided with Twilight's installation.
3. If using Special Material Libraries, be sure these libraries are located in a network location or are copied on all machines of all users of Twilight. If the library is located on the network, be sure all user copies of Twilight include that material folder location in it's list of Materials Directories.

When sharing a Twilight Render scene with another Twilight user not on the same network or who may not have access to the .IES or texture files used in the scene, be sure to share all files and material libraries referenced, and follow these steps to pack everything together to share:

1. Open the Scene you wish to share
2. Open the Render Window
3. Click the XML button and export as XML. Choose "yes" when it asks to save textures and IES files.
4. Copy the .skp file into the folder with the textures, IES, and XML format file.
5. Delete the .xml file. (optional, but will make file size smaller)
6. Zip the folder and send to a friend with Twilight.
7. They can now open the scene and hit render.
SketchyPhysics Animations

SketchyPhysics is an awesome plugin for SketchUp that allows you to create scenes with physical, 'newtonian' behavior. This means you make wheels roll, blocks fall, walls break, and almost anything your imagination can come up with.

Using Twilight, it's easy to render great animations of your SketchyPhysics masterpieces. For those of you who are unfamiliar, here is a brief 'how to...'

First, you'll need SketchyPhysics installed. Follow the link above to find the latest.
Depending on your experience with SP, you may need to take some time to learn how to use it. There is a lot of functionality in there.

-but-

If you just want to run a simple test, make sure the SketchyPhysics solids toolbar is showing:

• Add a solid floor
• Add a sphere
• Move the sphere above the surface of the floor
• Go ahead and hit the Play button, just to make sure it's working.

Once you have your SP scene setup, here's what you need to do:

Twilight renders animation using SketchUp's built in animation controls.
For this, you'll need multiple scenes to render any animation. (It will work with a minimum of one scene and just entering number of seconds of SP animation.)

• Go ahead and add a scene if you haven't already.
• For a simple demonstration, add a second scene. If you want the camera view to be animated, move to a new location. If not, add it in the exact spot as the first scene.
• Tweak your SU animation settings to get the length of time you want. It's always recommended to set the Scene Delay to 0.

Open the Twilight Render window.

• Go to the Animation tab.
  • Change the drop down from 'No Animation' to 'Has Animated Objects'
  • Set your start time to 0, and your stop time to the end of your simulation, like 2 seconds if you only have 2 scenes, with no scene delay and the default transition time.
  • Now set your Frame Rate.
    • If you want to make sure you get your whole SP simulation, hit the SketchyPhysics play button, and watch the status bar. It will tell you how many frames have elapsed.
    • Take that number, and divide by the number of seconds in your render (IE. 70 frames, 2 seconds, your frame rate is 35 frames per second).
    • Now set your base image name. Twilight will create a sequence of images starting with that name, and appending numbers like 0001, 0002 etc. Set the appropriate extension for the image type. The default is jpg.
    • Now make sure the 'Allow SketchyPhysics to run' button is checked.

• Go to the Render Tab
  • Under presets, select Express->Animation->Preview Object Animation
  • If you want a better quality preset, you can choose one of the others, like Low+ Object Animation through High+ Object Animation.

Now hit the render button. Twilight will run through the animation, advancing SketchyPhysics by one frame for each rendered frame. When it's done, you can run your sequence through your favorite video maker and voila, a great animation! You can set the starting number for SketchyPhysics frames in an animation to "fast-forward" or to resume previous animation render by choosing the "Starting SP Frame #".

Some things to keep in mind:

• You must check the Use Sketchy Replay box in order to activate Sketchy Replay features.
• Do not attempt to interact with SketchUp while rendering an animation. Hitting any of the SketchyPhysics buttons while rendering, or attempting to manipulate the view will cause unstable results, and may crash SketchUp.
• You can cancel the animation render at any time by hitting the Cancel button in the render window.
• While using the interactive tonemapping features while rendering will work, it will only effect the currently rendered frame, so should be avoided.

When your render is complete, the SketchyPhysics objects will be reset to their original locations and Twilight will notify you that it is complete.
That's all there is to it. It should take only minutes to set up Twilight for rendering a great looking animation using the awesome features of SketchyPhysics.
Sky Portal: The Sky Portal Material is for use on models of interiors where they rely heavily, or are lit only using Sun and Sky.

The Sky Portal material is found in the Architectural_Twilight Material Library provided with the Twilight Render plugin installation. Two additional Sky Portal materials can be downloaded in a special Material Library for Licensed Users from the Twilight Render Forum here. One of the Sky Portal materials found there will allow you to gain the benefits of the Sky Portal while still allowing you to see the sky and objects outside of the window.

The Sun and Sky cast light rays onto your model in a random way. If some of those rays make it through an opening and bounce around inside your model, they will light up your scene.

Low render settings are fast because they tell the lights not to cast a lot of light rays. Therefore they will not work well for your scene attempting to light an interior with light only coming from the Sun and Sky. Higher render settings are required, so that more rays are cast, and therefore, hopefully, more of these random light rays make it in through the openings into the interior of the model.

If only there were something that told the Sun and Sky exactly where the openings into the model were, and acted like a "door man" for the light rays saying "come on in here, guys"... that would be useful.

A Sky Portal is just that. It is a plane that covers any opening into an interior model and acts like the door man. When working properly it will take ALL rays of light from the Sun and Sky and bring them thru the "Sky Portal"

- Make a face that completely covers the opening - the Front of the Face pointing IN towards the inside of the model.
- Pick any unused color in SketchUp's material pallette and paint the Front of the face of that Sky Portal Plane.
- Now in SketchUp's material editor rename the material something like "Sky Portal"
- Now with Twilight's Material Tool apply the Sky Portal Material definition from the Library called "Sky Portal"
- Now when rendering with any method it will be working with all light info possible from only the Sun and Sky light outside.
- Easy09 would still be the render method of choice.
- However, even if rendered with "Easy 02 - Low" you will get high quality lighting, considering how little light set up has been done.
- Rendering time will increase significantly for non-progressive render methods because of all the light bounces now being calculated, so start with the lowest render setting possible and work your way up when using Sky Portals. Conversely, render times for Easy09 or 10 may actually decrease...difficult to quantify this because of the view/scene dependancy.

Keys to Sky Portals:

- Use the least number of surfaces possible... no curving surfaces!
- No light must be able to enter from the Sun and Sky into the model from any other way except through the Sky Portal.
- If 3 windows are on one wall, be sure to use a single plane to cover all 3 windows... the fewer portals the better/faster.
- Be sure the portal covers completely/intersects the window or opening... not a crack of light may enter the opening without first going through the portal.
- Be sure the face is pointing into the model... the direction you want the light to travel from the sun and sky to get into the model.
**Spherical Sky (Skies) Background**

A Spherical Sky Background is an image that is made especially to be used for surrounding your model inside a seamless “sphere” that looks like a sky or like a sky and ground. This image may be a High Dynamic Range image, or may only be a .jpg format. Either way, it will contribute light to the rendering. An HDR will contribute a lot more light than a .jpg format image. Typically with HDR lighting, it is best to disable the sun.

Is there a way to know how the sky will look in the render, like a “preview”?

1. load sky via **Sun & Sky Options Tab**
2. go to the scene you want to preview
3. hide your model, (ctrl-A to select all then Edit>hide selected)
4. choose “Easy 08” render setting
5. Render. If different rotation needed, Rotate Sky with Rotation Slider on **Sun & Sky Options Tab** as desired and re-render.

**Themes for Twilight User Interface**

Here are samples of the available themes and how they will appear on a system using Windows XP. Change the theme using the **Dialogs** tab in **The Twilight Options Dialog**.

**Two-Point Perspective (2-Point Perspective)**

Two-Point Perspective is a camera mode in SketchUp that forces all verticals in a scene to be truly vertical. When in any camera view in SketchUp activate Two-Point Perspective via the Camera>Two-Point Perspective menu option.

Twilight will *only* render the Two-Point Perspective if it has NOT been panned or otherwise manipulated after activating the feature from the SketchUp Camera Menu.
Uninstall/Reinstall Twilight Render

Be sure you have your original license email if you are upgrading a version after v0.19. (your version number is in the Twilight Options dialog.) The email contains the text you will need to paste in after reinstallation.

1. Copy your Twilight Materials folder to a safe place as a backup. (just in case, this may be an unnecessary step... TWL likely will not uninstall any extra mat packs you installed yourself.)
   "C:\Program Files (x86)\Google\Google SketchUp 7\Plugins\Twilight\Materials"

2. find this file on your machine and double click it...
   "C:\Program Files (x86)\Google\Google SketchUp 7\Plugins\unins000.exe"

3. Uninstall should now be complete. Look in the Plugins folder and verify that the "Twilight" Folder has been completely deleted.

   Now to verify the uninstall...
   1. Find a file called "AppData\Twilight" on your computer:
      This can be found on Windows Systems in a path something like : (you will need to enable the viewing of hidden folders in Windows' Folder Options!)
      - XP: C:\Documents and Settings\Customer\Application Data\Twilight\n      - Vista: C:\Documents and Settings\User\Application Data\Twilight\n      - or C:\Users\Username\AppData\Roaming\Twilight
      - Windows 7: C:\Users\Your_name\AppData\Roaming\Twilight
   2. Delete that file if it's still there.

Reinstallation of Twilight Render:

   1. Restart your machine
   2. Rename your SketchUp "Plugins" folder to "PluginsBAK" (C:\Program Files (x86)\Google\Google SketchUp 7\PluginsBAK)
   3. Create a new folder called "Plugins" (C:\Program Files (x86)\Google\Google SketchUp 7\Plugins)
   4. Download fresh/latest version of Twilight from http:\\www.TwilightRender.com
   5. Run the .exe installation file. Make sure to allow it to install everything it asks to install. (including extra windows libraries)
   7. You should have only the basic SU tools PLUS the Twilight Toolbar should appear.
   8. Open scene and try rendering. Verify there is no crashing.
   9. Work a while, make sure everything is working well.
   10. open Windows Explorer.
   11. copy the contents of the Plugins folder. (select all and CTRL-C)
   12. now navigate to the PluginsBAK folder
   13. now CTRL-V paste in all the new Twilight Plugin "stuff" into the PluginsBAK folder. (C:\Program Files (x86)\Google\Google SketchUp 7\PluginsBAK)
      If it asks if you want to replace anything be sure to choose “Yes”.
   14. If you can now see the new files are added to that folder, delete the folder called "Plugins". (...Google SketchUp 7\Plugins)
   15. RENAME the folder from "PluginsBAK" to be "Plugins" (...Google SketchUp 7\PluginsBAK>Plugins)
   16. Copy your Materials from your backup place wherever you saved them, and put them in the new fresh clean Materials folder found in Plugins\Twilight\Materials.
      If you have the Organizer Script plugin... be sure to exclude TWILIGHT by adding it to the exclusion text file BEFORE OPENING SKETCHUP.
   17. Close/Reopen SketchUp and Install the license via the Options Dialog in Twilight Render.
Twilight Render is built on the exceptional quality of the Kerkythea Echo 2008 Render Engine.

Kerkythea has quietly been the render engine of choice for professionals, students, and hobbyists around the world for many years. Now Twilight allows anyone using Google SketchUp, from the extreme novice to the hi-end professional rendering specialist easy access to the world-renowned Kerkythea from within Google SketchUp. For questions regarding Kerkythea and its usage, please refer to the Kerkythea Website.

Contributing Artists
Material Libraries are used and distributed with permission from their authors. Claudio Pilustrelli, Patrick Nieborg, Alexandre Mur. Thank you for your generosity and creativity! For access to many more great material libraries that are compatible with Twilight Render, please refer to the Kerkythea Website.

A special “thank you” goes to Ioannis Pantazopoulos, who has given so much rendering power and enjoyment so generously to so many people for so many years.

Special Thanks
A special thanks to Kim Frederik, Miguel Lescano Cornejo, and Pentti Lahdenperä for their steadfast selfless contribution to the Twilight Render community and the continued improvement and development of the Twilight Render Plugin for Google SketchUp. Their knowledge, insight, and friendship is invaluable.